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Instructional icons
Before you start, familiarise yourself with the icons 
you will see in this manual: 

Warning—situations that could cause 
injury to yourself or others

Caution—situations that could cause 
damage to your phone or other 
equipment

Note—notes, usage tips, or additional 
information 

 Refer to—pages with related information; 
for example:  p.12 (represents “see 
page 12”)
using this
manual

This user manual has been specially designed to
guide you through the functions and features of your

mobile phone. To get started quickly,
refer to “introducing your mobile phone,”

“assembling and preparing your mobile phone,”
and “using basic functions.”
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Copyright information
Rights to all technologies and products that 
comprise this device are the property of their 
respective owners:

• Bluetooth® is a registered trademark of the 
Bluetooth SIG, Inc. worldwide—Bluetooth QD 
ID: B0xxxxx.

• Java™ is a trademark of Sun Microsystems, Inc.
• Windows Media Player® is registered trademark 

of Microsoft Corporation.
→ Followed by—the order of options or 
menus you must select to perform a step; 
for example: Press <Menu> → 
Messages → Create new message 
(represents Menu, followed by 
Messages, followed by Create new 
message)

[      ] Square brackets—phone keys; for 
example: [ ] (represents the Power/ 
Menu exit key)

<    > Angled brackets—softkeys that control 
different functions at each screen; for 
example: <OK> (represents the OK 
softkey)
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Health and safety information
Exposure to radio frequency
(RF) signals

Certification Information (SAR)

Your wireless phone is a radio transmitter and receiver. It 
is designed and manufactured not to exceed the exposure 
limits for radio frequency (RF) energy set by the Federal 
Communications Commission (FCC) of the U.S. 
government. These FCC exposure limits are derived from 
the recommendations of two expert organizations, the 
National Counsel on Radiation Protection and 
Measurement (NCRP) and the Institute of Electrical and 
Electronics Engineers (IEEE). In both cases, the 
recommendations were developed by scientific and 
engineering experts drawn from industry, government, 
and academia after extensive reviews of the scientific 
literature related to the biological effects of RF energy.

The exposure limit set by the FCC for wireless mobile 
phones employs a unit of measurement known as the 
Specific Absorption Rate (SAR). The SAR is a measure of 
the rate of absorption of RF energy by the human body 
expressed in units of watts per kilogram (W/kg). The FCC 
requires wireless phones to comply with a safety limit of 
1.6 watts per kilogram (1.6 W/kg). The FCC exposure limit 
incorporates a substantial margin of safety to give 
additional protection to the public and to account for any 
variations in measurements.

SAR tests are conducted using standard operating 
positions accepted by the FCC with the phone transmitting 
at its highest certified power level in all tested frequency 
bands. Although the SAR is determined at the highest 
certified power level, the actual SAR level of the phone 
while operating can be well below the maximum value. 
This is because the phone is designed to operate at 
multiple power levels so as to use only the power required 
to reach the network. In general, the closer you are to a 
wireless base station antenna, the lower the power 
output.
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Before a new model phone is available for sale to the 
public, it must be tested and certified to the FCC that it 
does not exceed the exposure limit established by the 
FCC. Tests for each model phone are performed in 
positions and locations (e.g. at the ear and worn on the 
body) as required by the FCC. 

The highest SAR values for this model phone as reported 
to the FCC are : 

GSM850 Head: 0.203 W/Kg, Body-worn: 0.751 W/Kg.

GSM1900 Head: 0.087 W/Kg, Body-worn: 0.102 W/Kg.

For body worn operations, this model phone has been 
testde and meets the FCC exposure guidelines when used 
with a Samsung accessory designated for this product or 
when used with an accessroy that contains no metal and 
that positons the handset a minimum 1.5 cm from the 
body. 

Non-compliance with the above restrictions may result in 
violation of FCC RF exposure guidelines.

SAR information on this and other model phones can be 
viewed on-line at www.fcc.gov/oet/fccid. This site uses the 
phone FCC ID number A3LSWDI6210.

Sometimes it may be necessary to remove the battery 
pack to find the number. Once you have the FCC ID 
number for a particular phone, follow the instructions on 
the website and it should provide values for typical or 
maximum SAR for a particular phone. Additional product 
specific SAR information can also be obtained at 
www.fcc.gov/cgb/sar.

Consumer Information on Wireless Phones

The U.S. Food and Drug Administration (FDA) has 
published a series of Questions and Answers for 
consumers relating to radio frequency (RF) exposure from 
wireless phones. The FDA publication includes the 
following information:

What kinds of phones are the subject of this update?

The term wireless phone refers here to hand-held wireless 
phones with built-in antennas, often called “cell,” “mobile,” 
or “PCS” phones. These types of wireless phones can 
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expose the user to measurable radio frequency energy 
(RF) because of the short distance between the phone and 
the user's head. These RF exposures are limited by 
Federal Communications Commission safety guidelines 
that were developed with the advice of FDA and other 
federal health and safety agencies. When the phone is 
located at greater distances from the user, the exposure to 
RF is drastically lower because a person's RF exposure 
decreases rapidly with increasing distance from the 
source. The so-called “cordless phones,” which have a 
base unit connected to the telephone wiring in a house, 
typically operate at far lower power levels, and thus 
produce RF exposures well within the FCC's compliance 
limits.

Do wireless phones pose a health hazard?

The available scientific evidence does not show that any 
health problems are associated with using wireless 
phones. There is no proof, however, that wireless phones 
are absolutely safe. Wireless phones emit low levels of 
radio frequency energy (RF) in the microwave range while 
being used. They also emit very low levels of RF when in 
the stand-by mode. Whereas high levels of RF can produce 
health effects (by heating tissue), exposure to low level RF 

that does not produce heating effects causes no known 
adverse health effects. Many studies of low level RF 
exposures have not found any biological effects. Some 
studies have suggested that some biological effects may 
occur, but such findings have not been confirmed by 
additional research. In some cases, other researchers 
have had difficulty in reproducing those studies, or in 
determining the reasons for inconsistent results.

What is FDA's role concerning the safety of wireless 
phones?

Under the law, FDA does not review the safety of 
radiation-emitting consumer products such as wireless 
phones before they can be sold, as it does with new drugs 
or medical devices. However, the agency has authority to 
take action if wireless phones are shown to emit radio 
frequency energy (RF) at a level that is hazardous to the 
user. In such a case, FDA could require the manufacturers 
of wireless phones to notify users of the health hazard and 
to repair, replace or recall the phones so that the hazard 
no longer exists.

Although the existing scientific data do not justify FDA 
regulatory actions, FDA has urged the wireless phone 
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industry to take a number of steps, including the 
following:

• “Support needed research into possible biological 
effects of RF of the type emitted by wireless phones;

• “Design wireless phones in a way that minimizes any 
RF exposure to the user that is not necessary for 
device function; and

• “Cooperate in providing users of wireless phones with 
the best possible information on possible effects of 
wireless phone use on human health.

FDA belongs to an interagency working group of the 
federal agencies that have responsibility for different 
aspects of RF safety to ensure coordinated efforts at the 
federal level. The following agencies belong to this 
working group:

• “National Institute for Occupational Safety and Health
• “Environmental Protection Agency
• ”Federal Communications Commission
• ”Occupational Safety and Health Administration.
• ”National Telecommunications and Information 

Administration

The National Institutes of Health participates in some 
interagency working group activities, as well.

FDA shares regulatory responsibilities for wireless phones 
with the Federal Communications Commission (FCC). All 
phones that are sold in the United States must comply 
with FCC safety guidelines that limit RF exposure. FCC 
relies on FDA and other health agencies for safety 
questions about wireless phones.

FCC also regulates the base stations that the wireless 
phone networks rely upon. While these base stations 
operate at higher power than do the wireless phones 
themselves, the RF exposures that people get from these 
base stations are typically thousands of times lower than 
those they can get from wireless phones. Base stations 
are thus not the primary subject of the safety questions 
discussed in this document.

What are the results of the research done already?

The research done thus far has produced conflicting 
results, and many studies have suffered from flaws in their 
research methods. Animal experiments investigating the 
effects of radio frequency energy (RF) exposures 
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characteristic of wireless phones have yielded conflicting 
results that often cannot be repeated in other laboratories. 
A few animal studies, however, have suggested that low 
levels of RF could accelerate the development of cancer in 
laboratory animals. However, many of the studies that 
showed increased tumor development used animals that 
had been genetically engineered or treated with cancer-
causing chemicals so as to be pre-disposed to develop 
cancer in absence of RF exposure. Other studies exposed 
the animals to RF for up to 22 hours per day. These 
conditions are not similar to the conditions under which 
people use wireless phones, so we don't know with 
certainty what the results of such studies mean for human 
health.

Three large epidemiology studies have been published 
since December 2000. Between them, the studies 
investigated any possible association between the use of 
wireless phones and primary brain cancer, glioma, 
meningioma, or acoustic neuroma, tumors of the brain or 
salivary gland, leukemia, or other cancers. None of the 
studies demonstrated the existence of any harmful health 
effects from wireless phones RF exposures. However, none 
of the studies can answer questions about long-term 

exposures, since the average period of phone use in these 
studies was around three years.

What research is needed to decide whether RF 
exposure from wireless phones poses a health risk?

A combination of laboratory studies and epidemiological 
studies of people actually using wireless phones would 
provide some of the data that are needed. Lifetime animal 
exposure studies could be completed in a few years. 
However, very large numbers of animals would be needed 
to provide reliable proof of a cancer promoting effect if 
one exists. Epidemiological studies can provide data that 
is directly applicable to human populations, but ten or 
more years' follow-up may be needed to provide answers 
about some health effects, such as cancer. This is because 
the interval between the time of exposure to a cancer-
causing agent and the time tumors develop - if they do - 
may be many, many years. The interpretation of 
epidemiological studies is hampered by difficulties in 
measuring actual RF exposure during day-to-day use of 
wireless phones. Many factors affect this measurement, 
such as the angle at which the phone is held, or which 
model of phone is used.
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What is FDA doing to find out more about the 
possible health effects of wireless phone RF?

FDA is working with the U.S. National Toxicology Program 
and with groups of investigators around the world to 
ensure that high priority animal studies are conducted to 
address important questions about the effects of exposure 
to radio frequency energy (RF).

FDA has been a leading participant in the World Health 
Organization international Electromagnetic Fields (EMF) 
Project since its inception in 1996. An influential result of 
this work has been the development of a detailed agenda 
of research needs that has driven the establishment of 
new research programs around the world. The Project has 
also helped develop a series of public information 
documents on EMF issues.

FDA and Cellular Telecommunications & Internet 
Association (CTIA) have a formal Cooperative Research 
and Development Agreement (CRADA) to do research on 
wireless phone safety. FDA provides the scientific 
oversight, obtaining input from experts in government, 
industry, and academic organizations. CTIA-funded 
research is conducted through contracts to independent 
investigators. The initial research will include both 

laboratory studies and studies of wireless phone users. 
The CRADA will also include a broad assessment of 
additional research needs in the context of the latest 
research developments around the world.

What steps can I take to reduce my exposure to 
radio frequency energy from my wireless phone?

If there is a risk from these products - and at this point we 
do not know that there is - it is probably very small. But if 
you are concerned about avoiding even potential risks, 
you can take a few simple steps to minimize your 
exposure to radio frequency energy (RF). Since time is a 
key factor in how much exposure a person receives, 
reducing the amount of time spent using a wireless phone 
will reduce RF exposure.

• “If you must conduct extended conversations by 
wireless phone every day, you could place more 
distance between your body and the source of the RF, 
since the exposure level drops off dramatically with 
distance. For example, you could use a headset and 
carry the wireless phone away from your body or use a 
wireless phone connected to a remote antenna.

Again, the scientific data do not demonstrate that wireless 
phones are harmful. But if you are concerned about the RF 
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exposure from these products, you can use measures like 
those described above to reduce your RF exposure from 
wireless phone use.

What about children using wireless phones?

The scientific evidence does not show a danger to users of 
wireless phones, including children and teenagers. If you 
want to take steps to lower exposure to radio frequency 
energy (RF), the measures described above would apply 
to children and teenagers using wireless phones. Reducing 
the time of wireless phone use and increasing the distance 
between the user and the RF source will reduce RF 
exposure.

Some groups sponsored by other national governments 
have advised that children be discouraged from using 
wireless phones at all. For example, the government in the 
United Kingdom distributed leaflets containing such a 
recommendation in December 2000. They noted that no 
evidence exists that using a wireless phone causes brain 
tumors or other ill effects. Their recommendation to limit 
wireless phone use by children was strictly precautionary; 
it was not based on scientific evidence that any health 
hazard exists.

Do hands-free kits for wireless phones reduce risks 
from exposure to RF emissions?

Since there are no known risks from exposure to RF 
emissions from wireless phones, there is no reason to 
believe that hands-free kits reduce risks. Hands-free kits 
can be used with wireless phones for convenience and 
comfort. These systems reduce the absorption of RF 
energy in the head because the phone, which is the source 
of the RF emissions, will not be placed against the head. 
On the other hand, if the phone is mounted against the 
waist or other part of the body during use, then that part 
of the body will absorb more RF energy. Wireless phones 
marketed in the U.S. are required to meet safety 
requirements regardless of whether they are used against 
the head or against the body. Either configuration should 
result in compliance with the safety limit.

Do wireless phone accessories that claim to shield 
the head from RF radiation work?

Since there are no known risks from exposure to RF 
emissions from wireless phones, there is no reason to 
believe that accessories that claim to shield the head from 
those emissions reduce risks. Some products that claim to 
shield the user from RF absorption use special phone 
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cases, while others involve nothing more than a metallic 
accessory attached to the phone. Studies have shown that 
these products generally do not work as advertised. Unlike 
“hand-free” kits, these so-called “shields” may interfere

with proper operation of the phone. The phone may be 
forced to boost its power to compensate, leading to an 
increase in RF absorption. In February 2002, the Federal 
trade Commission (FTC) charged two companies that sold 
devices that claimed to protect wireless phone users from 
radiation with making false and unsubstantiated claims. 
According to FTC, these defendants lacked a reasonable 
basis to substantiate their claim.

What about wireless phone interference with 
medical equipment?

Radio frequency energy (RF) from wireless phones can 
interact with some electronic devices. For this reason, FDA 
helped develop a detailed test method to measure 
electromagnetic interference (EMI) of implanted cardiac 
pacemakers and defibrillators from wireless telephones. 
This test method is now part of a standard sponsored by 
the Association for the Advancement of Medical 
instrumentation (AAMI). The final draft, a joint effort by 
FDA, medical device manufacturers, and many other 

groups, was completed in late 2000. This standard will 
allow manufacturers to ensure that cardiac pacemakers 
and defibrillators are safe from wireless phone EMI. FDA 
has tested wireless phones and helped develop a 
voluntary standard sponsored by the Institute of Electrical 
and Electronic Engineers (IEEE). This standard specifies 
test methods and performance requirements for hearing 
aids and wireless phones so that no interference occurs 
when a person uses a compatible phone and a compatible 
hearing aid at the same time. This standard was approved 
by the IEEE in 2000.

FDA continues to monitor the use of wireless phones for 
possible interactions with other medical devices. Should 
harmful interference be found to occur, FDA will conduct 
testing to assess the interference and work to resolve the 
problem.

Additional information on the safety of RF exposures from 
various sources can be obtained from the following 
organizations:

• FCC RF Safety Program:
http://www.fcc.gov/oet/rfsafety/

• Environmental Protection Agency (EPA):
http://www.epa.gov/radiation/
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• Occupational Safety and Health Administration's 
(OSHA): 
http://www.osha.gov/SLTC/radiofrequencyradiation/
index.html

• National institute for Occupational Safety and Health 
(NIOSH):
http://www.cdc.gov/niosh/emfpg.html

• World health Organization (WHO):
http://www.who.int/peh-emf/

• International Commission on Non-Ionizing Radiation 
Protection:
http://www.icnirp.de

• National Radiation Protection Board (UK):
http://www.nrpb.org.uk

• Updated 4/3/2002: US food and Drug Administration
http://www.fda.gov/cellphones

Road Safety
Your wireless phone gives you the powerful ability to 
communicate by voice, almost anywhere, anytime. But an 
important responsibility accompanies the benefits of 
wireless phones, one that every user must uphold.

When driving a car, driving is your first responsibility. 
When using your wireless phone behind the wheel of a car, 
practice good common sense and remember the following 
tips:

1. Get to know your wireless phone and its features, such 
as speed dial and redial. If available, these features 
help you to place your call without taking your 
attention off the road.

2. When available, use a hands-free device. If possible, 
add an additional layer of convenience and safety to 
your wireless phone with one of the many hands free 
accessories available today.

3. Position your wireless phone within easy reach. Be 
able to access your wireless phone without removing 
your eyes from the road. If you get an incoming call at 
an inconvenient time, let your voice mail answer it for 
you.

4. Let the person you are speaking with know you are 
driving; if necessary, suspend the call in heavy traffic 
or hazardous weather conditions. Rain, sleet, snow, ice 
and even heavy traffic can be hazardous.

5. Do not take notes or look up phone numbers while 
driving. Jotting down a “to do” list or flipping through 
your address book takes attention away from your 
primary responsibility, driving safely.
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6. Dial sensibly and assess the traffic; if possible, place 

calls when you are not moving or before pulling into 
traffic. Try to plan calls when your car will be 
stationary. If you need to make a call while moving, 
dial only a few numbers, check the road and your 
mirrors, then continue.

7. Do not engage in stressful or emotional conversations 
that may be distracting. Make people you are talking 
with aware you are driving and suspend conversations 
that have the potential to divert your attention from 
the road.

8. Use your wireless phone to call for help. Dial 9-1-1 or 
other local emergency number in the case of fire, 
traffic accident or medical emergencies. Remember, it 
is a free call on your wireless phone!

9. Use your wireless phone to help others in 
emergencies. If you see an auto accident, crime in 
progress or other serious emergency where lives are 
in danger, call 9-1-1 or other local emergency number, 
as you would want others to do for you.

10. Call roadside assistance or a special non-emergency 
wireless assistance number when necessary. If you 
see a broken-down vehicle posing no serious hazard, a 
broken traffic signal, a minor traffic accident where no 
one appears injured, or a vehicle you know to be 

stolen, call roadside assistance or other special non-
emergency number.

“The wireless industry reminds you to use your 
phone safely when driving.”

For more information, please call 1-888-901-SAFE, or visit 
our web-site www.wow-com.com

Provided by the Cellular Telecommunications & Internet 
Association

Operating Environment

Remember to follow any special regulations in force in any 
area and always switch your phone off whenever it is 
forbidden to use it, or when it may cause interference or 
danger. When connecting the phone or any accessory to 
another device, read its user's guide for detailed safety 
instructions. Do not connect incompatible products.

As with other mobile radio transmitting equipment, users 
are advised that for the satisfactory operation of the 
equipment and for the safety of personnel, it is 
recommended that the equipment should only be used in 
the normal operating position (held to your ear with the 
antenna pointing over your shoulder).
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Using Your Phone Near Other Electronic 
Devices

Most modern electronic equipment is shielded from radio 
frequency (RF) signals. However, certain electronic 
equipment may not be shielded against the RF signals 
from your wireless phone. Consult the manufacturer to 
discuss alternatives.

Pacemakers

Pacemaker manufacturers recommend that a minimum 
distance of 15 cm (6 inches) be maintained between a 
wireless phone and a pacemaker to avoid potential 
interference with the pacemaker.

These recommendations are consistent with the 
independent research and recommendations of Wireless 
Technology Research.

Persons with pacemakers:
• should always keep the phone more than 15 cm (6 

inches) from their pacemaker when the phone is 
switched on.

• should not carry the phone in a breast pocket.
• should use the ear opposite the pacemaker to 

minimize potential interference.

If you have any reason to suspect that interference is 
taking place, switch your phone off immediately.

Hearing Aids

Some digital wireless phones may interfere with some 
hearing aids. In the event of such interference, you may 
wish to consult your hearing aid manufacturer to discuss 
alternatives.

Other Medical Devices

If you use any other personal medical devices, consult the 
manufacturer of your device to determine if it is 
adequately shielded from external RF energy. Your 
physician may be able to assist you in obtaining this 
information. Switch your phone off in health care facilities 
when any regulations posted in these areas instruct you to 
do so. Hospitals or health care facilities may be using 
equipment that could be sensitive to external RF energy.

Vehicles

RF signals may affect improperly installed or inadequately 
shielded electronic systems in motor vehicles. Check with 
the manufacturer or its representative regarding your 
vehicle. You should also consult the manufacturer of any 
equipment that has been added to your vehicle.
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Posted Facilities

Switch your phone off in any facility where posted notices 
require you to do so.

Potentially Explosive Environments
Switch your phone off when in any area with a potentially 
explosive atmosphere and obey all signs and instructions. 
Sparks in such areas could cause an explosion or fire 
resulting in bodily injury or even death.

Users are advised to switch the phone off while at a 
refueling point (service station). Users are reminded of the 
need to observe restrictions on the use of radio equipment 
in fuel depots (fuel storage and distribution areas), 
chemical plants or where blasting operations are in 
progress.

Emergency Calls
This phone, like any wireless phone, operates using radio 
signals, wireless and landline networks as well as user 
programmed functions, which cannot guarantee 
connection in all conditions. Therefore, you should never 
rely solely on any wireless phone for essential 
communications (medical emergencies, for example).

Remember, to make or receive any calls the phone must 
be switched on and in a service area with adequate signal 
strength. Emergency calls may not be possible on all 
wireless phone networks or when certain network services 
and/or phone features are in use. Check with local service 
providers.

To make an emergency call:

1. If the phone is not on, switch it on.
2. Key in the emergency number for your present 

location (for example, 911 or other official emergency 
number). Emergency numbers vary by location.

3. Press [SEND].

If certain features are in use (call barring, for example), 
you may first need to deactivate those features before you 
can make an emergency call. Consult this document and 
your local cellular service provider.

When making an emergency call, remember to give all the 
necessary information as accurately as possible. 
Remember that your phone may be the only means of 
communication at the scene of an accident; do not cut off 
the call until given permission to do so.

Restricting Children's access to your Phone
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Your phone is not a toy. Children should not be allowed to 
play with it because they could

FCC Notice and Cautions

FCC Notice

This device complies with Part 15 of the FCC Rules. 
Operation is  subject to the following two conditions:  

(1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, 
including interference that may cause undesired                 
operation.

This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation.

This equipment generates, uses and can radiate radio 
frequency energy and,f not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications.

However, there is no guarantee that interference will not 
occur in a particular installation.If this equipment does 
cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct 
theinterference by one or more of the following measures:

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV 

technician for help.

The phone may cause TV or radio interference if used in 
close proximity to receiving equipment. The FCC can 
require you to stop using the phone if such interference 
cannot be eliminated.

Vehicles using liquefied petroleum gas (such as propane or 
butane) must comply with the National Fire Protection 
Standard (NFPA-58). For a copy of this standard, contact 
the National Fire Protection Association, One Battery 
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march Park, Quincy, MA 02269, Attn: Publication Sales 
Division.

Cautions

Changes or modifications made in the radio phone, not 
expressly approved by Samsung, will void the user°Øs 
authority to operate the equipment.

Only use approved batteries, antennas and chargers. The 
use of any unauthorized accessories may be dangerous 
and void the phone warranty if said accessories cause 
damage or a defect to the phone.

Although your phone is quite sturdy, it is a complex piece 
of equipment and can be broken. Avoid dropping, hitting, 
bending or sitting on it.

Other Important Safety Information.
• Only qualified personnel should service the phone or 

install the phone in a vehicle. Faulty installation or 
service may be dangerous and may invalidate any 
warranty applicable to the device.

• Check regularly that all wireless phone equipment in 
your vehicle is mounted and operating properly.

• Do not store or carry flammable liquids, gases or 
explosive materials in the same compartment as the 
phone, its parts or accessories.

• For vehicles equipped with an air bag, remember that 
an air bag inflates with great force. Do not place 
objects, including both installed or portable wireless 
equipment in the area over the air bag or in the air 
bag deployment area. If wireless equipment is 
improperly installed and the air bag inflates, serious 
injury could result.

• Switch your phone off before boarding an aircraft. The 
use of wireless phone in aircraft is illegal and may be 
dangerous to the aircraft's operation.

• Failure to observe these instructions may lead to the 
suspension or denial of telephone services to the 
offender, or legal action, or both.

Product Performance

Getting the Most Out of Your Signal Reception

The quality of each call you make or receive depends on 
the signal strength in your area. Your phone informs you 
of the current signal strength by displaying a number of 
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bars next to the signal strength icon. The more bars 
displayed, the stronger the signal.

If you're inside a building, being near a window may give 
you better reception.

Understanding the Power Save Feature

If your phone is unable to find a signal after 15 minutes of 
searching, a Power Save feature is automatically 
activated. If your phone is active, it periodically rechecks 
service availability or you can check it yourself by pressing 
any key.

Anytime the Power Save feature is activated, a message 
displays on the screen. When a signal is found, your phone 
returns to standby mode.

Understanding How Your Phone Operates

Your phone is basically a radio transmitter and receiver. 
When it's turned on, it receives and transmits radio 
frequency (RF) signals. When you use your phone, the 
system handling your call controls the power level. This 
power can range from 0.006 watts to 0.2 watts in digital 
mode.

Maintaining Your Phone's Peak Performance

For the best care of your phone, only authorized personnel 
should service your phone and accessories. Faulty service 
may void the warranty.

There are several simple guidelines to operating your 
phone properly and maintaining safe, satisfactory service.

• Hold the phone with the antenna raised, fully-
extended and over your shoulder.

• Try not to hold, bend or twist the phone's antenna.
• Don't use the phone if the antenna is damaged.
• Speak directly into the phone's receiver.
• Avoid exposing your phone and accessories to rain or 

liquid spills. If your phone does get wet, immediately 
turn the power off and remove the battery. If it is 
inoperable, call Customer Care for service.
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Availability of Various Features/Ring 
Tones

Many services and features are network dependent and 
may require additional subscription and/or usage charges. 
Not all features are available for purchase or use in all 
areas. Downloadable Ring Tones may be available at an 
additional cost. Other conditions and restrictions may 
apply. See your service provider for additional information.

Battery Standby and Talk Time
Standby and talk times will vary depending on phone 
usage patterns and conditions. Battery power 
consumption depends on factors such as network 
configuration, signal strength, operating temperature, 
features selected, frequency of calls, and voice, data, and 
other application usage patterns. 

Battery Precautions.
• Avoid dropping the cell phone. Dropping it, 

especially on a hard surface, can potentially cause 
damage to the phone and battery. If you suspect 
damage to the phone or battery, take it to a 
service center for inspection. 

• Never use any charger or battery that is damaged 
in any way.

• Use the battery only for its intended purpose.
• If you use the phone near the network's base 

station, it uses less power; talk and standby time 
are greatly affected by the signal strength on the 
cellular network and the parameters set by the 
network operator.

• Follow battery usage, storage and charging 
guidelines found in the user’s guide.

• Battery charging time depends on the remaining 
battery charge and the type of battery and charger 
used. The battery can be charged and discharged 
hundreds of times, but it will gradually wear out. 
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When the operation time (talk time and standby 
time) is noticeably shorter than normal, it is time 
to buy a new battery.

• If left unused, a fully charged battery will 
discharge itself over time.

• Use only Samsung-approved batteries and 
recharge your battery only with Samsung-
approved chargers. When a charger is not in use, 
disconnect it from the power source. Do not leave 
the battery connected to a charger for more than a 
week, since overcharging may shorten its life.

• Do not use incompatible cell phone batteries and 
chargers. Some Web sites and second-hand 
dealers, not associated with reputable 
manufacturers and carriers, might be selling 
incompatible or even counterfeit batteries and 
chargers. Consumers should purchase 
manufacturer or carrier recommended products 
and accessories. If unsure about whether a 
replacement battery or charger is compatible, 
contact the manufacturer of the battery or charger. 

• Extreme temperatures will affect the charging 
capacity of your battery: it may require cooling or 
warming first.

• Do not leave the battery in hot or cold places, such 
as in a car in summer or winter conditions, as you 
will reduce the capacity and lifetime of the battery. 
Always try to keep the battery at room 
temperature. A phone with a hot or cold battery 
may temporarily not work, even when the battery 
is fully charged. Li-ion batteries are particularly 
affected by temperatures below 0 °C (32 °F).

• Do not place the phone in areas that may get very 
hot, such as on or near a cooking surface, cooking 
appliance, iron, or radiator.

• Do not get your phone or battery wet. Even though 
they will dry and appear to operate normally, the 
circuitry could slowly corrode and pose a safety 
hazard.

• Do not short-circuit the battery. Accidental short- 
circuiting can occur when a metallic object (coin, 
clip or pen) causes a direct connection between the 
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+ and - terminals of the battery (metal strips on 
the battery), for example when you carry a spare 
battery in a pocket or bag. Short-circuiting the 
terminals may damage the battery or the object 
causing the short-circuiting.

• Do not permit a battery out of the phone to come 
in contact with metal objects, such as coins, keys 
or jewelry.

• Do not crush, puncture or put a high degree of 
pressure on the battery as this can cause an 
internal short-circuit, resulting in overheating. 

• Dispose of used batteries in accordance with local 
regulations. In some areas, the disposal of 
batteries in household or business trash may be 
prohibited.  For safe disposal options for Li-Ion 
batteries, contact your nearest Samsung 
authorized service center.  Always recycle. Do not 
dispose of batteries in a fire.

• Battery usage by children should be supervised.

Care and Maintenance

Your phone is a product of superior design and 
craftsmanship and should be treated with care. The 
suggestions below will help you fulfill any warranty 
obligations and allow you to enjoy this product for many 
years.

• Keep the phone and all its parts and accessories out of 
the reach of small children.

• Keep the phone dry. Precipitation, humidity and liquids 
contain minerals that will corrode electronic circuits.

• Do not use the phone with a wet hand. Doing so may 
cause an electric shock to you or damage to the 
phone.

• Do not use or store the phone in dusty, dirty areas, as 
its moving parts may be damaged.

• Do not store the phone in hot areas. High 
temperatures can shorten the life of electronic 
devices, damage batteries, and warp or melt certain 
plastics.

• Do not store the phone in cold areas. When the phone 
warms up to its normal operating temperature, 
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moisture can form inside the phone, which may 
damage the phone's electronic circuit boards.

• Do not drop, knock or shake the phone. Rough 
handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents or 
strong detergents to clean the phone. Wipe it with a 
soft cloth slightly dampened in a mild soap-and-water 
solution.

• Do not paint the phone. Paint can clog the device's 
moving parts and prevent proper operation.

• Do not put the phone in or on heating devices, such as 
a microwave oven, a stove or a radiator. The phone 
may explode when overheated.

• When the phone or battery gets wet, the label 
indicating water damage inside the phone changes 
color. In this case, phone repairs are no longer 
guaranteed by the manufacturer's warranty, even if 
the warranty for your phone has not expired.

• If your phone has a flash or light, do not use it too 
close to the eyes of people or animals. This may cause 
damage to their eyes.

• Use only the supplied or an approved replacement 
antenna. Unauthorized antennas or modified 
accessories may damage the phone and violate 
regulations governing radio devices.

• If the phone, battery, charger or any accessory is not 
working properly, take it to your nearest qualified 
service facility. The personnel there will assist you, and 
if necessary, arrange for service.
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Unpack
Check your product box for the following items:

• Mobile phone
• Battery
• Travel adapter (charger)
• User manual 

The items supplied with your phone may vary 
depending on the software and accessories 
available in your region or offered by your 
service provider.
You can obtain additional accessories from 
your local Samsung dealer.
introducing your
mobile phone

 In this section, learn about your mobile phone’s
layout, keys, display, and icons.
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The rear of your phone includes the following keys 
and features:

Battery cover

Camera lens
TV antenna

Multifunction jack

Internal antenna

External display
Phone layout
The front of your phone includes the following keys 
and features:

Power/Menu exit key

Mouthpiece

Left softkey

Dial key

Special
function keys

4-way
navigation key

Web access/
Confirm key

Right softkey

Application 
switch keyVolume key

Earpiece

Main display

TV key

Memory card slot

Delete/Cancel key
Alphanumeric keys



Delete/
Cancel

Delete characters; In Menu mode, 
return to the previous level

Power/
Menu exit

Turn the phone on and off (press and 
hold); End a call; In Menu mode, 
cancel input and return to Idle mode

Alpha-
numeric

Enter numbers, letters and special 
characters; In Idle mode, press and 
hold [1] to access voice mails and [0] 
to enter an international call prefix

Special 
function

Enter special characters or perform 
special functions; In Idle mode, press 
and hold [ ] for the Silent profile; 
Press and hold [ ] to enter a pause 
between numbers

Volume Adjust the phone’s volume

Key Function
12
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Keys

Key Function

Softkeys Perform actions indicated at the 
bottom of the display

Navigation
In Idle mode, access user-defined 
menus; In Menu mode, scroll 
through menu options

Web 
access/
Confirm

In Idle mode, launch the web 
browser; In Menu mode, select the 
highlighted menu option or confirm 
an input

Application 
switch

Open the application switch window 
to access other applications without 
exiting the current application

Dial
Make or answer a call; In Idle mode, 
retrieve recently dialed, missed, or 
received numbers
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Icons
Learn about the icons that appear on your display.

Icon Definition

Signal strength

SOS message feature activated

GPRS network connected

EDGE network connected

Voice call in progress

Connected with PC

Browsing the web

Connecting to secured web page

Call diverting activated
Display
Your phone’s display consists of three areas:

TV
In Idle mode, turn on the TV; Access 
the TV menu (press and hold); While 
watching TV, change the view mode

Key Function

Icon line
Displays various icons

Text and graphic area
Displays messages, 
instructions, and 
information you enter

Softkey line
Displays the current actions 
assigned to each softkey

Select               Back



Meeting profile activated

Outdoor profile activated

Offline profile activated

Battery power level

TV program recording in progress

TV program recording or watching reserved

Icon Definition
14
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Roaming (outside of normal service area)

Memory card inserted

New text message (SMS)

New multimedia message (MMS)

New email message

New voice mail message

New push message

New configuration message

Silent profile activated

Driving profile activated

Icon Definition
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Install the SIM card and battery
When you subscribe to a cellular service, you will 
receive a Subscriber Identity Module, or SIM card, 
with subscription details, such as your personal 
identification number (PIN) and optional services.

To install the SIM card and battery,

1. Remove the battery cover.

If the phone is on, press and hold [ ] to turn it 
off.
assembling and
preparing your
mobile phone

 Get started by assembling and setting up
 your mobile phone for its first use.



3. Insert the battery.

4. Replace the battery cover.
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2. Insert the SIM card.

Place the SIM card in the phone with the gold-
colored contacts facing down.
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2. Plug the large end of the travel adapter into a 
power outlet.

3. When the battery is fully charged (the  icon is 
no longer moving), unplug the travel adapter from 
the power outlet.

4. Unplug the adapter from the phone.

5. Close the cover to the multifunction jack.

About the low battery indicator
When your battery is low, the phone will emit a 
warning tone and a low battery message. The 
battery icon will also be empty and blinking. If 
the battery level becomes too low, the phone 
will automatically power off. Recharge your 
battery to continue using your phone.
Charge the battery
Before using the phone for the first time, you must 
charge the battery.

1. Open the cover to the multifunction jack and plug 
the small end of the travel adapter.

Improperly connecting the travel adapter can 
cause serious damage to the phone. Any 
damages by misuse are not covered by the 
warranty.

With the triangle facing up



To remove the memory card, push it gently until it 
disengages from the phone, and then pull the 
memory card out of the memory card slot.
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Insert a memory card (optional)
To store additional multimedia files, you must insert a 
memory card. Your phone accepts microSD™ 
memory cards up to 4 GB (depending on memory 
card manufacturer and type).

1. Open the cover to the memory card slot on the 
side of the phone.

2. Insert a memory card with the label side facing 
up.

3. Push the memory card in the memory card slot 
until it locks in place.
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urn your phone on and off
 turn your phone on,

. Open the phone.

. Press and hold [ ]. 

. Enter your PIN and press <Confirm> 
(if necessary).

 turn your phone off, repeat steps 1 and 2 above.

witch to the Offline profile
y switching to the Offline profile, you can use your 
hone’s non-network services in areas where 
ireless devices are prohibited, such as airplane 
d hospitals.

 switch to the Offline profile, press <Menu> → 
ettings → Profiles → Offline.

Follow all posted warnings and directions from 
official personnel when in areas where wireless 
devices are prohibited.
using basic
functions

 Learn how to perform basic operations and use the
main features of your mobile phone.

T
To

1

2

3

To

S
B
p
w
an

To
S



• WAP: launch the web browser
• Music player: launch the music player

2. Scroll to the application and press <Select>.
To end all applications, press [ ], scroll to End all?, 
and press <Yes>.

Customize your phone
Get more from your phone by customizing it to 
match your preferences.

Adjust the volume of the key tones
In Idle mode, press [ / ] to adjust the key tone 
volume.

Switch to or from the Silent profile
In Idle mode, press and hold [ ] to silence or 
unsilence your phone.
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Access menus
To access your phone’s menus,

1. Press a softkey for the menu you want.

2. Use the navigation key to scroll to a menu or 
option.

3. Press <Select>, <Save>, or [OK] to confirm the 
highlighted option.

4. Press <Back> or [C] to move up one level; 
Press [ ] to return to Idle mode.

Switch applications
Learn to switch to other applications from a menu, 
without closing the menu screen you are using.

1. While using a menu, press [ ]. The following 
applications are available:
• Call: open the dialing screen
• Messages: access the Messages menu
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2. Select Pictures → an image category → an 

image.

3. Press <Set>.

Set menu shortcuts
1. In Idle mode, press <Menu> → Settings → 

Phone settings → Shortcuts.

2. Select a key to use as a shortcut.

3. Select a menu to assign to the shortcut key.

Lock your phone
1. In Idle mode, press <Menu> → Settings → 

Security → Phone lock.

2. Select On.

3. Enter a new 4- to 8-digit password and press 
<Confirm>.

4. Enter the new password again and press 
<Confirm>. 
Change your ringtone
1. In Idle mode, press <Menu> → Settings → 

Profiles.

2. Scroll to the profile you are using.

3. Press <Options> → Edit → Voice call Ring 
Tune.

4. Scroll left or right to a memory location 
(if necessary).

5. Select a ringtone category → a ringtone.

6. Press <Options> → Save.
To switch to another profile, select it from the list.

Select a wallpaper (Idle mode)
1. In Idle mode, press <Menu> → Settings → 

Display & light settings → Main display → 
Wallpaper.



Use the speakerphone feature
1. During a call, press [OK] to activate the speaker.

2. To switch back to the earpiece, press [OK] 
again.

Use the headset
By plugging the supplied headset into the 
multifunction jack, you can make and answer calls:

• To redial the last call, press the headset button, 
and then press again and hold.

• To answer a call, press and hold the headset 
button.

• To end a call, press and hold the headset button.
22
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Use basic call functions
Learn to make or answer calls and use basic call 
functions.

Make a call
1. In Idle mode, enter an area code and a phone 

number.

2. Press [ ] to dial the number.

3. To end the call, press [ ]. 

Answer a call
1. When a call comes in, press [ ].

2. To end the call, press [ ].

Adjust the volume
To adjust the volume during a call, press [ / ].
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7. Press <Options> → Send to send the 

message.

Send an email
1. In Idle mode, press <Menu> → Messages → 

Create new message → Email.

2. Enter an email address and scroll down.

3. Enter a subject and scroll down.

4. Enter your email text.

5. Press <Options> → Add attachment or Create 
item and attach a file (if necessary).

6. Press <Options> → Send to send the 
message.
Send and view messages
Learn to send and view text (SMS), multimedia 
(MMS), and email messages.

Send a text or multimedia message
1. In Idle mode, press <Menu> → Messages → 

Create new message → Message.

2. Enter a destination number and scroll down.

3. Enter your message text.  p. 24
For sending as a text message, skip to step 8.
For attaching multimedia, continue with step 4.

4. Press <Options> → Add item → an item type.

5. Select the item you want to add and press 
<Select>.

6. Press <Options> → Add subject and enter a 
subject.



View text or multimedia messages
1. In Idle mode, press <Menu> → Messages → 

Inbox.

2. Select a text or multimedia message.

T9

1. Press the appropriate alphanumeric 
keys to enter an entire word.

2. When the word displays correctly, press 
[ ] to insert a space. If the correct word 
does not display, press [0] to select an 
alternate word.

Number Press the appropriate alphanumeric key to 
enter a number.

Symbol Press the appropriate alphanumeric key to 
select a symbol.

Mode Function
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Enter text
When entering text, you can change the text input 
mode:

• Press and hold [ ] to switch between T9 and 
ABC modes.

• Press [ ] to change case or switch to Number 
mode.

• Press and hold [ ] to switch to Symbol mode.
Enter text in one of the following modes:

Mode Function

ABC
Press the appropriate alphanumeric key until 
the character you want appears on the 
display.
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3. Select a number type (if necessary).

4. Enter contact information.

5. Press <Options> → Save or press <Save> to 
add the contact to memory.

Find a contact
1. In Idle mode, press <Menu> → Contacts.

2. Enter the first few letters of the name you want to 
find.

3. Select the contact’s name from the search list.

Once you have found a contact, you can:
• call the contact by pressing [ ]
• edit the contact information by pressing  

<Options> → Edit
View an email
1. In Idle mode, press <Menu> → Messages → 

Email inbox.

2. Press <Options> → Download.

3. Select an email or a header.

4. If you selected a header, press <Options> → 
Retrieve to view the body of the email.

Add and find contacts
Learn the basics of using the Phonebook feature.

Add a new contact
1. In Idle mode, enter a phone number and press 

<Options>.

2. Select Save to Contacts → a memory location 
(phone or SIM) → New. 



5. Press <Yes>.
The phone scans and saves the available TV 
channels.

6. Select a program.

7. While watching TV, use the following keys:

8. To turn off the TV, press [ ].

Key Function

Navigation left 
or right

Change the channel

Navigation up 
or down; /

Adjust the volume up or down

Change the view mode

<Options> Access TV options
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Watch digital TV
Learn to watch digital TV with your phone.

1. Pull out the TV antenna and adjust it to receive a 
stronger broadcast signal.

2. In Idle mode, press [ ] to turn on the TV.

3. When you turn on the TV for the first time, press 
<Yes> to create a channel list.

4. Enter a title of the channel list and press [OK].



27

using basic functions
Capture videos
1. In Idle mode, press <Menu> → Camera to turn 

on the camera.

2. Press [1] to switch to Recording mode.

3. Aim the lens at the subject and make any 
adjustments.

4. Press [OK] to start recording.

5. Press <Stop> to stop recording. 
The video is saved automatically.

View videos
In Idle mode, press <Menu> → Play → Videos → a 
video file.
Use basic camera functions
Learn the basics to capture and view photos and 
videos.

Capture photos
1. In Idle mode, press <Menu> → Camera to turn 

on the camera.

2. Aim the lens at the subject and make any 
adjustments.

3. Press [OK] to take a photo. 
The photo is saved automatically.

View photos
In Idle mode, press <Menu> → Play → Images → a 
photo file.



3. Control playback using the following keys:

Key Function

OK Pause or resume playback

/ Adjust the volume up or down

Navigation

• Left: Restart playback; Skip 
backward (press within 3 
seconds); Scan backward in a file 
(press and hold)

• Right: Skip forward; Scan forward 
in a file (press and hold)

• Up: Open the playlist
• Down: Stop playback
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Listen to music
Learn how to listen to music via the music player.

Start by transferring files to your phone or memory 
card:

• Download from the wireless web.  p. 29
• Download from a PC with the optional Samsung 

PC Studio.  Samsung PC Studio user manual
• Receive via Bluetooth.  p. 40
• Copy to your memory card.  p. 37
• Synchronize with Windows Media Player 11. 

 p. 37
After transferring music files to your phone or 
memory card,

1. In Idle mode, press <Menu> → Media → Music 
Player.

2. Select a music category → a music file.
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Bookmark your favorite web pages
1. In Idle mode, press <Menu> → WAP → 

Bookmarks.

2. Press <Options> → Add bookmark.

3. Enter a page title and a web address (URL).

4. Press <Save>.
Browse the web
Learn to access and bookmark your favorite web 
pages.

Browse web pages
1. In Idle mode, press [OK] to launch your service 

provider’s homepage.

2. Navigate web pages using the following keys:

Key Function

Navigation Scroll up or down on a web page

OK Select an item

<Back> Return to the previous page

<Options> Access a list of browser options
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Use advanced call functions
Learn about your phone’s additional calling 
capabilities. 

View and dial missed calls
Your phone will display calls you have missed on the 
display. To dial the number of a missed call,

1. Press <View>.

2. Scroll to the missed call you want to dial.

3. Press [ ] to dial.

Call a recently dialed number
1. In Idle mode, press [ ] to display a list of 

recent numbers.

2. Scroll to the number you want and press [ ] to 
dial.
using advanced
functions

 Learn how to perform advanced operations and use
additional features of your mobile phone.
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Answer a second call
If your network supports this function, you can 
answer a second incoming call:

1. Press [ ] to answer the second call.
The first call is automatically placed on hold.

2. Press <Options> → Swap to switch between 
the calls.

Make a multiparty call (conference call)
1. Call the first party you want to add to the 

multiparty call.

2. While connected to the first party, call the 
second party.
The first party is automatically placed on hold.

3. When connected to the second party, press 
<Options> → Join.
Hold a call or retrieve a held call
Press <Options> → Hold to place a call on hold or 
press <Resume> to retrieve a held call.

Dial a second call
If your network supports this function, you can dial 
another number during a call:

1. Press <Options> → Hold to place the first call 
on hold.

2. Enter the second number to dial and press [ ].

3. Press <Options> → Swap to switch between 
the two calls.

4. To end the call on hold, press <Options> → End 
→ Held call.

5. To end the current call, press [ ].



Use advanced Contacts functions
Learn to create namecards, set speed dial numbers, 
and create groups of contacts.

Create a namecard
1. In Idle mode, press <Menu> → Contacts.

2. Press <Options> → My Business card.

3. Enter your personal details and press <Options> 
→ Save.

Set speed dial numbers
1. In Idle mode, press <Menu> → Contacts.

2. Scroll to a contact to assign.

3. Press <Options> → Assign speed dial.

You can send your namecard by attaching it to 
a message or email or transferring it via the 
Bluetooth wireless feature.
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4. Repeat steps 2 and 3 to add more parties (if 
necessary).

5. To end the multiparty call, press [ ].

Call an international number
1. In Idle mode, press and hold [0] to insert the + 

character.

2. Enter the complete number you want to dial 
(country code, area code, and phone number), 
and then press [ ] to dial. 

Call a contact from Contacts
You can call numbers directly from Contacts using 
stored contacts.  p. 25

1. In Idle mode, press <Menu> → Contacts.

2. Scroll to the number you want to dial and press 
[ ] to dial. 
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5. To set the caller ID image, scroll to the new group 

and press <Options> → Group settings → 
Picture → an image category → an image → 
<Select>.

6. To set a group ringtone, scroll down and press 
[OK] → a ringtone category → a ringtone → 
<Select>.

7. Press <Options> → Save.

Use advanced messaging functions
Learn to create templates and use templates to 
create new messages.

Create a text template
1. In Idle mode, press <Menu> → Messages → 

Templates → Text templates.

2. Press <Options> → Add new to open a new 
template window.
4. Scroll to a number you want to set (4-7, and 9) 
and press <Select>.
The contact is saved to the speed dial number.

Create a group of contacts
By creating groups of contacts, you can assign 
ringtones and caller ID photos to each group or send 
messages and emails to an entire group. Start by 
creating a group:

1. In Idle mode, press <Menu> → Contacts.

2. Scroll left or right to Groups.

3. Press <Options> → Create group.

4. Enter a group name and press <Save>.

You can now call this contact from Idle mode 
by pressing and holding the assigned speed 
dial number.



Insert text templates in new messages
1. To start a new message, press <Menu> → 

Messages → Create new message → a 
message type.

2. Scroll down to the text field, and press 
<Options> → Insert → Text template → a 
template.

Create a message from a multimedia 
template
1. In Idle mode, press <Menu> → Messages → 

Templates → Multimedia message templates.

2. Scroll to the template you want and press 
<Options> → Send.
Your template opens as a new multimedia 
message.
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3. Enter your text and press [OK] to save the 
template.

Create a multimedia template
1. In Idle mode, press <Menu> → Messages → 

Templates → Multimedia message templates.

2. Press <Add new>.

3. Create a multimedia message, with a subject 
and desired attachments, to use as your 
template.  p. 23

4. From the message screen, press <Options> → 
Save as template.
The message is now saved as a multimedia 
template with a preset name, such as ‘Birthday.’
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3. Press <Options> → Stop to stop recording. The 

video file will be saved in Recorded TV (press 
and hold [ ]).

Reserve a TV program
1. In Idle mode, press [ ] to turn on the TV.

2. Press <TV guide> to view the TV guide.

3. Scroll to a program and press [OK].

4. Press <Reservation>.

5. Scroll left or right to a reservation mode 
(recording or watching).

6. Set the details to reserve the TV program (if 
necessary).

7. Press <Save>.
Use advanced TV functions
Learn to show subtitles, record a TV program, 
reserve a TV program, and customize TV settings.

Show subtitles
1. In Idle mode, press [ ] to turn on the TV.

2. Press <Options> → Show subtitle.

Record a TV program
To record and save a TV program, you must insert a 
memory card into the phone.

1. In Idle mode, press [ ] to turn on the TV.

2. Press <Options> → Record to start recording.

The subtitle and program reservation services 
may not be available depending on your 
service provider.



Use advanced music functions
Learn to prepare music files and create playlists.

Copy music files via Samsung PC Studio
1. In Idle mode, press <Menu> → Settings → 

Connectivity → Select USB mode → PC 
studio.

2. Press [ ] to return to Idle mode.

3. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC.

4. Run Samsung PC Studio and copy files from the 
PC to the phone.
Refer to the Samsung PC Studio help for more 
information.
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Customize TV settings
In Idle mode, press and hold [ ] → Settings. The 
following options are available:

• Channel navigation: set whether you navigate all 
available channels or the channels in the channel 
list

• Display brightness: adjust the brightness
• Sounds: select a TV sound mode or language for 

audio
• Incoming Message: set how to display incoming 

messages while watching TV
• Auto Power Off: set to automatically power off 

the TV after a specified duration
• Parental lock: set an age limit for accessing TV 

programs. To view an age restricted program, you 
must enter a preset password.
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Copy music files to a memory card
1. Insert a memory card.

2. In Idle mode, press <Menu> → Settings → 
Connectivity → Select USB mode → Mass 
Storage.

3. Press [ ] to return to Idle mode.

4. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear 
on the PC.

5. Select Open folder to view files in the pop-up 
window on the PC.

6. Copy files from the PC to the memory card.
Synchronize your phone with Windows 
Media Player
1. In Idle mode, press <Menu> → Settings → 

Connectivity → Select USB mode → Media 
player.

2. Press [ ] to return to Idle mode.

3. Using an optional PC data cable, connect the 
multifunction jack on your phone to a PC with 
Windows Media Player installed.
When connected, a pop-up window will appear 
on the PC.

4. Select Sync digital media files to this device in 
the pop-up window on the PC.

5. Edit or enter your phone’s name in the pop-up 
window (optional), and then click Finish.



Customize your music player settings
Learn to adjust the playback and sound settings for 
your music player.

1. In Idle mode, press <Menu> → Media → Music 
Player.

2. Press <Options> → Player settings.

3. Adjust the settings to customize your music 
player. 

4. Press <Save>.
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Create a playlist
1. In Idle mode, press <Menu> → Media → Music 

Player → Playlists.

2. Press <Options> → Create playlist.

3. Enter a title for your new playlist and press 
<Save>.

4. Select the new playlist.

5. Press <Options> → Add → Files.

6. Select the files you want to include and press 
<OK>.
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Use the Bluetooth wireless feature
Learn about your phone’s ability to connect to other 
wireless devices for exchanging data and using 
hands-free features.

Turn on the Bluetooth wireless feature
1. In Idle mode, press <Menu> → Tools → 

Bluetooth → Activation → On.

2. To allow other devices to locate your phone, 
select My phone’s visibility → On.

Find and pair with other Bluetooth-
enabled devices
1. In Idle mode, press <Menu> → Tools → 

Bluetooth → My devices → Search new 
device.

2. Scroll to a device and press <Select>.
using tools and
applications

 Learn how to work with your mobile phone’s tools
and additional applications.



Receive data using the Bluetooth 
wireless feature
1. Enter the PIN for the Bluetooth wireless feature 

and press <OK> (if necessary).

2. Press <Yes> to confirm that you are willing to 
receive data from the device (if necessary).

Activate the mobile tracker
When someone inserts a new SIM card in your 
phone, the mobile tracker feature will automatically 
send the contact number to two recipients to help 
you locate and recover your phone. To activate the 
mobile tracker,

1. In Idle mode, press <Menu> → Settings → 
Security → uTrack.

2. Enter your password and press <Confirm>.

3. Scroll left or right to On.
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3. Enter a PIN for the Bluetooth wireless feature or 
the other device’s Bluetooth PIN, if it has one, 
and press <OK>.
When the owner of the other device enters the 
same code or accepts the connection, pairing is 
complete.

Send data using the Bluetooth wireless 
feature
1. Select the file or item from one of your phone’s 

applications that you want to send.

2. Press <Options> → Send Business card via or 
Send via → Bluetooth (when sending contact 
data, specify which data to send).
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3. Speak your memo into the microphone.

4. When you are finished speaking, press the 
navigation key down.

Play a voice memo
1. From the voice recorder screen, press 

<Options> → My voice clips.

2. Select a file.

3. Control the playback using the following keys:

Key Function

OK Pause or resume playback

/ Adjust the volume up or down

Navigation
• Left: Scan backward in a file
• Right: Scan forward in a file
• Down: Stop playback
4. Scroll down and press [OK] to open the recipient 
list.

5. Press <Options> → Contacts to open your 
contact list.

6. Select a contact  → a number.

7. Press <Options> → OK to save the recipients.

8. Scroll down and enter the sender’s name.

9. Press <Options> → Save → <Accept>.

Record and play voice memos
Learn to operate your phone’s voice recorder.

Record a voice memo
1. In Idle mode, press <Menu> → Media → Voice 

recorder.

2. Press [OK] to start recording.



2. Press <Options> to access a list of various 
options and settings for your application. 

Use the RSS reader
Learn to use the RSS reader to get the latest news 
and information from your favorite websites.

Create feeds
1. In Idle mode, press <Menu> → Tools → RSS 

Reader.

2. Press <Options> → Add.

3. Enter the address of an RSS feed and press 
<OK>.

4. Press <Options> → Add new to add more 
feeds (if necessary).
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Use Java-powered games and 
applications
Learn to use games and applications powered by 
award-winning Java technology.

Play games
1. In Idle mode, press <Menu> → Downloads → 

My Games.

2. Select a game from the list and follow the on-
screen instructions.

Launch applications
1. In Idle mode, press <Menu> → Downloads → 

My Games → an application.

Available games may vary, depending on your 
service provider or region. Game controls and 
options may vary.
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Customize RSS reader settings
1. In Idle mode, press <Menu> → Tools → RSS 

Reader.

2. Press <Options> → Settings.

3. Customize the settings as desired.

Use the Samsung Mobile Business 
service
Learn to use the Samsung Mobile Business (SMB) 
service to access your corporate MS Exchange 
Server when you are out of the office.

1. In Idle mode, press <Menu> → Tools → 
Samsung Mobile Business.

2. Enter your profile information and press <Next>.

3. When the SMB service is connected, send and 
receive emails, manage business contacts, or 
schedule business meetings.
Read RSS feeds
1. In Idle mode, press <Menu> → Tools → RSS 

Reader.

2. Press <Options> → Update → Selected or All 
to get the latest contents. 

3. Select a feed → an updated post.

Download multimedia
1. In Idle mode, press <Menu> → Tools → RSS 

Reader.

2. Scroll to a feed and press <Options> → Open.

3. Scroll to a post containing multimedia.

4. Press <Options> → Media → Download.

To download the multimedia later, select Save 
in Wishlist.



4. Press <Options> → Save.

Stop an alarm
When the alarm sounds,

• Press any key to stop an alarm without snooze.
• Press <OK> or [OK] to stop an alarm with snooze 

or press <Snooze> or any key to silence the 
alarm for the snooze period.

Deactivate an alarm
1. In Idle mode, press <Menu> → Tools → 

Alarms.

2. Scroll to the alarm you want to deactivate and 
press [OK].

The auto power-up feature sets the phone to 
automatically turn on and sound the alarm at 
the designated time if the phone is turned off.
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View world clocks
Learn to view the time in another city.

1. In Idle mode, press <Menu> → Tools → World 
Time.

2. Scroll left or right to a time zone.

3. To set daylight saving time, press <DST>.

4. Press [OK].

Set and use alarms
Learn to set and control alarms for important events.

Set a new alarm
1. In Idle mode, press <Menu> → Tools → 

Alarms.

2. Scroll to an empty alarm location and press [OK].

3. Set alarm details.
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Set a countdown timer
1. In Idle mode, press <Menu> → Tools → Timer.

2. Press <Set>.

3. Enter hours or minutes to count down and press 
<OK>.

4. Press [OK] to begin or pause the countdown.

5. When the timer expires, press <OK> to stop the 
alert.

Use the stopwatch
1. In Idle mode, press <Menu> → Tools → 

Stopwatch.

2. Press [OK] to begin and record lap times.

3. When you are finished, press <Stop>.

4. Press <Reset> to clear recorded times.
3. Scroll down (if necessary).

4. Scroll left or right to Off.

5. Press [OK].

Use the calculator
1. In Idle mode, press <Menu> → Tools → 

Calculator.

2. Use the keys that correspond to the calculator 
display to perform basic mathematical 
operations.

Convert measurements
1. In Idle mode, press <Menu> → Tools → 

Converter → a conversion type.

2. Enter the measurements and units in the 
appropriate fields.



Manage your calendar
Learn to change the calendar view and create 
events.

Change the calendar view
1. In Idle mode, press <Menu> → Tools → 

Calendar.

2. Press <Options> → View mode → Day view or 
Week view.

Create an event
1. In Idle mode, press <Menu> → Tools → 

Calendar.

2. Press <Options> → Create → an event type.

3. Enter the details of the event as required.

4. Press <Options> → Save.
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Create a new task
1. In Idle mode, press <Menu> → Tools → Tasks.

2. Press <Options> → Create.

3. Enter the details of the task and press [OK].

Create a text memo
1. In Idle mode, press <Menu> → Tools → Notes.

2. Press <Options> → Create.

3. Enter your memo text and press [OK].
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 troubleshooting procedures before contacting a service 

Enter PIN

When using the phone for the first time 
or when the PIN requirement is 
enabled, you must enter the PIN 
supplied with the SIM card. You can 
disable this feature by using the PIN 
check menu.

PUK Lock

Your SIM card is blocked, usually as a 
result of entering your PIN incorrectly 
several times. You must enter the PUK 
supplied by your service provider. 

Message Try this to solve the problem:
troub
If you are havi
professional.

When you tu
messages m

Message
Insert SIM 
card to 
access 
network 
services

Phone Lock
leshooting
ng trouble with your mobile phone, try these

rn on your phone, the following 
ay appear:

Try this to solve the problem:

Ensure that the SIM card is installed 
correctly.

When the phone lock feature is 
enabled, you must enter the password 
you set for the phone.



Ensure that you have not set call barring for the 
phone number.

nother caller cannot hear you speaking.

Ensure that you are not covering the built-in 
microphone.
Ensure that the microphone is close to your 
mouth.
If using a headset, ensure that it is properly 
connected.

he phone beeps and the battery icon flashes.

our battery is low. Recharge or replace the battery to 
ontinue using the phone.

he audio quality of the call is poor.

Ensure that you are not blocking the phone’s 
internal antenna.
When you are in areas with weak signals or poor 
reception, you may lose reception. Move to 
another area and try again.
b

troubleshooting

Your phone displays “No service” or “Service 
unavailable.”

• When you are in areas with weak signals or poor 
reception, you may lose reception. Move to 
another area and try again.

• You cannot access some options without a 
subscription. Contact your service provider for 
more details.

You enter a number, but the call is not dialed.

• Ensure that you have pressed the Dial key: [ ].
• Ensure that you have accessed the right cellular 

network.
• Ensure that you have not set call barring for the 

phone number.

Another caller cannot reach you.

• Ensure that your phone is turned on.
• Ensure that you have accessed the right cellular 

network.

•

A

•

•

•

T

Y
c

T

•

•



c

troubleshooting

You select a contact to call, but the call is not 
dialed.

• Ensure that the correct number is stored in the 
contact list.

• Re-enter and save the number, if necessary.

The battery does not charge properly or 
sometimes the phone turns itself off.

• The battery terminals may be dirty. Wipe both 
gold-colored contacts with a clean, soft cloth and 
try charging the battery again.

• If the battery will no longer charge completely, 
dispose of the old battery properly and replace it 
with a new battery.

• Your phone is hot to the touch when you use 
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